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macXware™ MacBurn™ User Guide 
 
This guide is distributed with software that includes an end-user agreement, this 
guide, as well as the software described in it, is furnished under license and may be 
used or copied only in accordance with the terms of such license. Except as 
permitted by any such license, no part of this guide may be reproduced, stored in a 
retrieval system, or transmitted, in any form or by any other means, electronic, 
mechanical, recording, or otherwise, without the prior written permission of 
Summitsoft Corporation. Please note that the content in this guide is protected 
under copyright law even if it is not distributed with the software that includes an 
end-user agreement. The content of this guide is furnished for informational use 
only, is subject to change without notice, and should not be construed as a 
commitment by Summitsoft Corporation. Summitsoft Corporation assumes no 
responsibility or liability for any errors or inaccuracies that may appear in the 
informational content contained in this guide. 
 
Please remember that existing artwork or images that you may want to include in 
your project may be protected under copyright law. The unauthorized incorporation 
of such material into your new work could be a violation of the rights of the 
copyright owner. Please be sure to obtain any permission required form the 
copyright owner. 
 
Any references to company names in sample templates are for demonstration 
purposes only and are not intended to refer to any actual organization. 
 
 
©2004 Macware Corporation. All rights reserved.  Macware, the Macware logo, 
macXware, the macXware logo, Summitsoft and the Summitsoft logo are either 
trademarks or registered trademarks of Summitsoft Corporation or Macware, Inc. in 
the United States and/or other countries. MacBurn is a trademark Macware, Inc., 
Apple, Mac, the Mac logo, the Made for Mac logo, Macintosh, QuickTime and 
TrueType are trademarks or registered trademarks of Apple Computer, Inc. in the 
United States and/or other countries. REAL Software, Incorporated. REAL 
Software, REALbasic and the REAL Software cube logo are registered trademarks 
of REAL Software, Inc.  Other product(s), font(s), and company names and logos 
may be trademarks or registered trademarks of their respective companies. 
 
macXware, P.O. Box 642116, Omaha, Nebraska 68164-2116, USA  
 
www.macXware.com
 

http://www.macxware.com/
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Welcome to MacBurn 
 
The easiest way to burn data DVD's, multi-session data CD's, 
audio CD's, erase CD-RW's & create disc images. 
 
MacBurn brings the power of CD & DVD burning to you in one 
easy-to-use application. Burn backups of your data or make a mix 
of your favorite tunes with a few simple clicks. 
You can even burn discs that can be read on Mac's, PC's or both! 
 
Registering macXware products 
 
Registering your macXware products is important. Registration 
provides you with timely access to the latest free product updates, 
technical support, valuable information about new product 
releases, access to free downloads, articles, tips and hints, and 
special offers. 
 
You can register online at www.macXware.com, and click on the 
Register button link. 
 
Installing MacBurn 
 
Insert the MacBurn CD-ROM in your CD-ROM drive. Once the CD-
ROM icon appears on the Desktop, double click on it to launch the 
Welcome Screen.  You can double click on the icon that says 
Install MacBurn to launch the installer. Follow the on-screen 
installation instructions.  This will install MacBurn to Applications 
directory on your Hard Disk and place a MacBurn alias on your 
desktop.

http://www.macxware.com/
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Customer Support 
 
The web address for macXware is www.macXware.com on the 
Internet. You can access general customer service, product 
information, frequently asked questions (FAQ’s) and technical 
support on this website. For additional support or specific customer 
service related questions not covered on the website, you may 
also mail, telephone, fax or email. The hours of operation are 9:00 
am to 5:00 pm, Eastern Time (EST), Monday through Friday. 
 
macXware 
P.O. Box 642116 
Omaha, NE 68164-2116 
 
Telephone:  402-554-1400 
Fax:   402-391-2413 
Email:   techsupport@macxware.com 
  comments@macxware.com 
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1.  Getting Started 
 
Welcome MacBurn user! 
 
Getting up and running with MacBurn is incredibly easy. 
 
To install MacBurn simply copy the MacBurn application to any 
location you wish (we recommend placing it in your Applications 
folder, but any location will do just fine). 
 
Please take a few moments to read over the System 
Requirements and brief instructions located within this manual. 
 
2.  System Requirements 
 
 •  Mac OS X 10.2.6 or higher (Mac OS X 10.3 recommended). 
 •  Optical media recording device, such as a CD burner for CD burning 

capability or a DVD burner for DVD burning capability, compatible with 
Mac OS X. (If your CD/DVD burner works with iTunes or the Finder it 
will work with MacBurn). 

 •  Disc Image (ISO & DMG) creation functionality only available under 
Mac OS X 10.3 or later. 

 •    700 MB of free HD space to burn roughly 80 minutes of Audio to CD. 

 
3.  Recording Data to a CD or DVD 
 
Step 1 - Insert a blank disc. 
 
Step 2 - Select the “Data” tab in MacBurn. 
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Step 3 - Add the files you want to include on your new CD or DVD. 
You can do this by dragging files to the file list in MacBurn or by 
clicking the “Add File” and “Add Folder” buttons. You can see 
how much space your files will take up on the disc in the bar at the 
bottom of the MacBurn window. 
 
Step 4 - Name your disc by typing a new name into the round text 
box in the upper right hand corner of the MacBurn Window. 
 
Step 5 - Select whether this disc will be read on a Mac, a PC or 
both using the drop down box next to the disc name box. 
 
Step 6 - Click the “Burn” toolbar button.   
 
Step 7 - Select your burn 
options and click “Burn”. 
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4.  How to Record an Audio CD 
 
Audio CD’s may be burned with MacBurn using a wide variety of 
QuickTime compatible file types (MP3’s, MOV’s, etc) as the source 
for audio tracks. 
 
Step 1 - Insert a blank disc. 
Step 2 - Select the “Audio” tab in MacBurn. 
 

  
Step 3 - Add the audio files you want to include on your new Audio 
CD. You may do this by dragging files to the file list in MacBurn or 
by clicking the “Add File” and “Add Folder” buttons. You can see 
how much total time your audio files will take up on the disc in the 
bar at the bottom of the MacBurn window. 
 
Step 4 - Click “Burn”. 
 
Step 5 - Select your burn options and click “Burn”. 
Note: While it is possible to burn multiple audio sessions to the 
same CD, it is not recommended as some very strange results can 
occur. However it is possible to allow additional data burns after 
burning a single audio session. 
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5.  Burning Multiple Sessions 
 
MacBurn allows you to burn multiple sessions to a single CD (Only 
Mac formatted Data CD’s are supported). This allows you to add, 
update or remove additional files and directories on your data CD 
at a later point in time, not just during a single recording session.  
  
The first time you burn a given CD (and every time you burn a 
session to it thereafter) make sure you check the “Allow 
Additional Burns” checkbox on the “Burn Options” sheet that 
appears when you burn a disc.  Checking this option will leave the 
CD “open” for additional writes. 
  
If you ever leave “Allow Additional Burns” unchecked you will not 
be able to burn another session to this CD! 
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6.  Creating and Burning Disc Images 
 
6.1  Making a new ISO or DMG disc image is similar to burning a 
new disc. 
 
Step 1 - Simply add the files you want to include in the disc image 
to MacBurn. 
 
Step 2 - Then select either "Save disc layout as DMG Image..." or 
"Save disc layout as PC/Mac Hybrid ISO Image..." from the file 
menu. 

 
 
Step 3 - You will then be prompted for the file name and location 
you would like to save the new disc image. 
 
Note: Creating a new disc image can take some time when you 
are dealing with larger files (or larger numbers of files). Also be 
sure that you have enough free space on volume which contains 
your MacBurn Temp folder (you will need twice as much free 
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space on the drive as MacBurn says is used for the particular disc 
layout if you plan on saving the disc image to the same volume as 
your Temp folder). 
 
6.2  Making an ISO or DMG image of an already existing drive or 
folder. 
 
Step 1 - Select “Save folder/volume as PC/Mac Hybrid ISO 
Image...” from the file menu. 
 
Step 2 - Select the folder or volume you wish to make an ISO disc 
image of. 
 
Step 3 - Give the new ISO image the name of your choice (it is not 
necessary to add “.iso” to the end of the file, this will happen 
automatically). 
 
Note: Make sure that the volume you save your new ISO image to 
has enough free space! If you are making an ISO backup of a 
folder that is 500 MB, be sure that the location you save it to has 
more than 500MB free. 
 
6.3  Burning a disc image 
 
If you have an existing Toast or ISO Disc image then you can burn 
that to any disc that is large enough to hold it. 
 
Simply insert a blank CD, select “Burn Toast Image” (or “Burn ISO 
Image”) from the File menu and select the Disc Image you wish to 
burn. 
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7.  Erasing a CD-RW 
 
First of all, make sure there is nothing you want on the disc you 
are about to erase! 
 
If you are completely sure, then insert the disc and click the “Erase 
Disc” button: 

 
 
Note: Erasing a disc may take quite a few minutes to complete. 
 
 
8.  Working with Burn Lists 
 
A Burn List is simply a small file that contains all the information 
about a disc you wish to burn.  This file can be saved and loaded 
to make repeatedly burning files much quicker and easier. 
 
Saving a Burn List is just like preparing to burn a new disc.  Except 
instead of clicking Burn, chose “Save Burn List” from the File 
menu. 
 
To load an existing Burn List simply choose “Open Burn List” 
from the File menu. 
 
Note: When a Burn List is loaded, but a file (or folder) that you had 
previously saved in that particular Burn List has been moved or 
renamed it will not show up in the MacBurn window. 
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9.  Platform Specific Files 
 
If you are creating a CD that will be used on multiple platforms 
(both Mac and PC) you can use MacBurn to hide some of the files 
when on a given platform.  Mac specific files can be made visible 
when on a Mac, but not on a PC. 
 
Step 1 – Add all the files you wish to burn to a Data disc. 
 
Step 2 – Select “Mac and PC Hybrid” from the drop down box 
located directly next to where you enter the disc name. 

 
Step 3 – Click on the File Info button.  
 
Step 4 – A drawer will now appear.  Select any given file in the 
MacBurn window and choose which systems this file will be visible 
on (Mac, PC or both). 
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10.  Troubleshooting 
 
Q: Every time I insert a blank CD or DVD into my drive a 
message pops up asking me what to do with the disc.  What 
do I do? 
A: You have two options: 
1) Simply choose ignore every time you insert a blank disc and this 
window pops up.   
2) Open your System Preferences application and select “CDs and 
DVDs” from the Hardware section.  From here you can customize 
what your Mac will do when a blank CD or DVD is inserted (simply 
ignore the disc, launch MacBurn, etc). 
 
Q: Is my CD/DVD burner compatible with MacBurn? 
A: If your burner is natively supported by Mac OS X then it is 
compatible with MacBurn.  An easy way to check this is to try to 
burn a CD with either the Finder or iTunes.  If you can’t burn a CD 
with either of those applications then it is not supported by 
MacBurn. 
 
Q: MacBurn fails to start up.  When I launch the application it 
just quits. 
A: If you have an external CD/DVD burner make sure it is plugged 
in correctly and turned on.  There are some circumstances where, 
if the burner is not turned on, MacBurn will fail to start. 
 
Q: Can I burn a video DVD that I can watch on my set top DVD 
player? 
A: No.  Set top DVD players connected to your television use a 
format called “UDF” which is not currently supported by MacBurn. 
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